# Table of Contents

Section 1: **Introduction** ............................................................................................................. 1  
1.1 System Requirements ...................................................................................................... 1  
1.2 Hardware Setup ............................................................................................................. 1  
1.3 Software Conventions .................................................................................................... 2  

Section 2: **Installation & Registration** .................................................................................. 3  
2.1 Installation ........................................................................................................................ 3  
   - Downloading from the Internet ............................................................................... 3  
2.2 Opening & Exiting the Application ............................................................................... 3  
2.3 Registration .................................................................................................................. 3  

Section 3: **Operation** ........................................................................................................... 5  
3.1 Splash Screen .................................................................................................................. 5  
   - Splash Screen Features .......................................................................................... 5  
   - Splash Screen Tasks .............................................................................................. 6  
   - Run Reports ............................................................................................................. 8  
   - Select a Meet ............................................................................................................ 8  
   - Printouts .................................................................................................................. 8  
   - Path & Generate Buttons ...................................................................................... 9  
   - Import A Meet .......................................................................................................... 9  
   - Export A Meet ......................................................................................................... 9  
   - Configure Scoreboard ........................................................................................... 9  
   - View Manual .......................................................................................................... 9  
   - Connect to OmniSport ............................................................................................. 9  
3.2 Configuring the Software ............................................................................................... 9  
   - Communication Configuration ............................................................................ 9  
   - Network Setup ...................................................................................................... 9  
   - Serial Port Setup ................................................................................................... 10  
   - Display Configuration ............................................................................................ 11  
3.3 Main Application Screen ............................................................................................. 12  
   - Events .................................................................................................................... 12  
   - Current Diver ......................................................................................................... 12  
   - Next Diver ............................................................................................................. 12  
   - Judge Scores ......................................................................................................... 12  
   - Diver Statistics ...................................................................................................... 13  
   - Event Order .......................................................................................................... 13  
   - Making Divers Active ........................................................................................... 13  
   - Adding/Removing Divers ...................................................................................... 13  
   - Editing Scores ....................................................................................................... 14  
   - Editing Diver Information ..................................................................................... 14  
   - Editing Dive List ................................................................................................. 14  
   - Editing Dives ....................................................................................................... 14  
   - Rearranging Divers .............................................................................................. 14  
   - Cutting/Uncutting Divers ..................................................................................... 15  
   - Round .................................................................................................................. 15  
   - Ranking .............................................................................................................. 15  
3.4 Ribbon Menu Bar .......................................................................................................... 16
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Meets</td>
<td>16</td>
</tr>
<tr>
<td>Meets</td>
<td>16</td>
</tr>
<tr>
<td>Divers</td>
<td>17</td>
</tr>
<tr>
<td>Events</td>
<td>17</td>
</tr>
<tr>
<td>In Meet</td>
<td>18</td>
</tr>
<tr>
<td>Dive Order</td>
<td>18</td>
</tr>
<tr>
<td>Scoring</td>
<td>18</td>
</tr>
<tr>
<td>Leaderboard</td>
<td>18</td>
</tr>
<tr>
<td>Dive Order</td>
<td>18</td>
</tr>
<tr>
<td>Reports</td>
<td>19</td>
</tr>
<tr>
<td>Event Results</td>
<td>19</td>
</tr>
<tr>
<td>Options</td>
<td>20</td>
</tr>
<tr>
<td>Share</td>
<td>20</td>
</tr>
<tr>
<td>DD Tables</td>
<td>20</td>
</tr>
<tr>
<td>Rosters</td>
<td>20</td>
</tr>
<tr>
<td>Setup</td>
<td>21</td>
</tr>
<tr>
<td>OmniSport Console</td>
<td>21</td>
</tr>
<tr>
<td>Display</td>
<td>21</td>
</tr>
<tr>
<td>DD Table</td>
<td>22</td>
</tr>
<tr>
<td>Speech</td>
<td>23</td>
</tr>
<tr>
<td>Web</td>
<td>23</td>
</tr>
<tr>
<td>Color Scheme</td>
<td>23</td>
</tr>
<tr>
<td>Help</td>
<td>23</td>
</tr>
<tr>
<td>Guides</td>
<td>23</td>
</tr>
<tr>
<td>About</td>
<td>23</td>
</tr>
<tr>
<td>OmniSport Start Button</td>
<td>24</td>
</tr>
<tr>
<td>New Meet</td>
<td>24</td>
</tr>
<tr>
<td>Open Meet</td>
<td>24</td>
</tr>
<tr>
<td>Edit Meet</td>
<td>24</td>
</tr>
<tr>
<td>Share</td>
<td>24</td>
</tr>
<tr>
<td>Print</td>
<td>24</td>
</tr>
<tr>
<td>Close</td>
<td>24</td>
</tr>
<tr>
<td>Splash Screen</td>
<td>24</td>
</tr>
<tr>
<td>Options</td>
<td>24</td>
</tr>
<tr>
<td>Exit</td>
<td>24</td>
</tr>
<tr>
<td>Recent Meets</td>
<td>24</td>
</tr>
<tr>
<td>Quick Access Toolbar</td>
<td>25</td>
</tr>
<tr>
<td>Customize Quick Access Toolbar</td>
<td>25</td>
</tr>
<tr>
<td>Maximize/Minimize the Ribbon (currently inactive)</td>
<td>25</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>25</td>
</tr>
</tbody>
</table>

**Appendix A:**  Software Revision History

---

**Table of Contents**
Section 1: Introduction

The OmniSport 2000 Pro Diving software interfaces with the OmniSport 2000 console to receive scores via judge consoles and also uses the console to interface with scoreboards and displays. The software can handle multiple meets with multiple events in each meet. Each event in turn can have unlimited divers in up to 99 rounds. Other features include synchronized diving and the ability to import and export to third party results programs such as DiveMeets.com and E-dive. The Pro Diving software does not verify dive sheets, but it does almost all other functions required to score an event.

This manual describes how to install, configure, and operate the Daktronics OmniSport 2000 Pro Diving software system, Version 3.0.0 or higher.

Daktronics identifies manuals by an ED or DD number located on the cover page of each manual. Any manuals referenced in this document will be identified by its ED/DD number. For example, this manual would be referred to as DD3109489.

1.1 System Requirements

The OmniSport 2000 Pro software operates on a Windows®-based computer. The following list describes the requirements for the OmniSport 2000 Pro Diving software:

- Windows XP operating system or better (Windows 7/8 is supported only in Pro Diving version 2.0.5.0 or higher - both 32 & 64 bit operating systems are supported)
- CPU and RAM must at least be equal to minimum requirements of operating system
- Internet Explorer® 6.0 or higher

The following list describes the optional equipment that may be used with the Pro software:

- One Ethernet jack OR one serial port for connection to the OmniSport 2000 console (one USB port and USB-to-serial adapter may be used in place of a serial port)
- Straight-through 9-pin male to 9-pin female serial cable
- OmniSport 2000 timing console
- RC-100 wireless (or JC-100 wired) judges consoles (2 min, 11 max)

1.2 Hardware Setup

The OmniSport 2000 Pro software is a computer interface to the OmniSport 2000 timing console. The software can be used to judge a diving event without the timing console, but there must be a console present to send the data to a scoreboard or to interface with the handheld judge consoles. The OmniSport 2000 timer must be connected properly to all competition equipment and accessories if using a display or judge consoles. Refer to Section 3.2 for more information on connecting to the OmniSport 2000 timer.
1.3 Software Conventions

This manual contains the following software conventions and terminology. Note that these instructions are based on the standard, right-handed mouse configuration.

<table>
<thead>
<tr>
<th>Bold</th>
<th>Indicates an item that requires direct action, such as clicking, pressing, selecting or formatting.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Italics</td>
<td>Indicates onscreen text or labels that are not clickable.</td>
</tr>
<tr>
<td>Bold Italics</td>
<td>Used to reference items within the manual, such as figures or sections, as well as other documents and important notes.</td>
</tr>
<tr>
<td>[X]</td>
<td>Represents a keyboard key that needs to be pressed.</td>
</tr>
<tr>
<td>“Quotes”</td>
<td>Text or commands that may be typed; also indicate file or folder names</td>
</tr>
<tr>
<td>Click</td>
<td>Press and release the left mouse button.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Press and release the left mouse button twice.</td>
</tr>
<tr>
<td>Right-click</td>
<td>Press and release the right mouse button.</td>
</tr>
<tr>
<td>Select</td>
<td>Highlight or mark, such as by placing a check mark (\checkmark) in a nearby box; clicking will not necessarily perform an action.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Followed by, as in menu navigation (ex. File &gt; Open).</td>
</tr>
</tbody>
</table>
Section 2: Installation & Registration

2.1 Installation

Downloading from the Internet
To install the Pro Diving software from the Internet:
1. Open an Internet browser to:
2. Click the “OmniSport Pro Diving (Web).exe” file, and then click Run (twice if necessary) to begin the installation procedure.
3. Follow the onscreen instructions to complete the installation.

2.2 Opening & Exiting the Application
To open the application:
- Double-click the “Diving” icon on the desktop (Figure 1).
- Click the Start menu and navigate to All Programs > Daktronics > OmniSport Pro > Diving.

To exit the application:
- Click the exit button in the upper-right corner of the window.
- Left- or right-click the icon in the upper-left corner of the window and click Close.
- Click the Daktronics ‘D’ in the upper-left corner and click Close or Exit.

2.3 Registration
After installing the Pro Diving software, users are given a 30 day trial period (Demo Mode). Each time the program is opened, the number of days remaining for the free trial is shown. To use the software without registering, click Continue. When the 30 day trial period is over, users must register the software as described below:

1. On the Daktronics Licensing window (Figure 2), make a note of the software Version number and Lock Code. Email this to sportsoftware@daktronics.com with the subject line “Pro Diving License”. Be sure to also include the name of your organization, facility name, and/or contract number for the fastest response.
2. Upon proof of purchase, Daktronics will email a software license file. Save the file to the Pro Diving computer in a location that is easy to remember, such as the “Desktop”.
3. Back on the Daktronics Licensing window, click Load License, browse to the location where the license file was saved, and then Open it.
4. After successfully registering, click Continue to begin using the software.

Note: Installing the software on a separate computer requires a new license file.
Section 3: Operation

3.1 Splash Screen

The Pro Diving splash screen (Figure 3) appears after the registration screen. This is a central hub for setting up the software, launching meets, and viewing completed, present, and upcoming meets. News and tips for the software are visible here as well. Below are descriptions of the available features and tasks that can be performed on the splash screen.

![Figure 3: Splash Screen](image)

Splash Screen Features

- **Schedule** shows Current, Past, and Future Meets for the preceding and following 30 days, depending on the selected date on the calendar in the upper left hand corner.

- **Recently Opened Meets** lists the Meet Name and Date for recently created/opened meets. Double-click a meet to quickly resume it.

- **Tips** offers short suggestions for operating and configuring the software. Click Previous Tip and Next Tip to see more helpful hints.

- **News** displays important notices and information about software releases and provides links to users so they always have the most up-to-date version of the software.

- **Common Tasks** provides frequently used functions within the software. All of these tasks are also available from within the main application.
Splash Screen Tasks

1. Click Resume Last Meet to instantly open the last opened meet. If no meets have been created, clicking this button will open the main application screen (see Section 3.3).

2. Click Open A Meet to select a previously created meet to open (Figure 4).
   - Choose the meet name from the drop-down list.
   - Click OK and the meet will open within the main application screen.

3. Click Create A Meet to begin a setup wizard to add new meets (Figure 5).
   - Type in a descriptive Meet Name.
   - Choose a date on the calendar if different from the current date, and then click Next.
   - On the following screen (Figure 6), users can Add, Delete, and Edit all of the events for the meet. To skip this step for now and add events at another time, click Finish.

4. Click Add Event to insert a new event to the meet (Figure 7).
   - Type in a descriptive Title for the event.
   - Select the number of Rounds, from 1-13.
   - Select a Gender, Male or Female.

   Note: Change the External settings (Number, Section, and Alpha) if necessary, to match those of the third-party Hy-Tek LTD MEET MANAGER software.

5. Click Next to continue.
• On the next screen (Figure 8), first set whether the event is Synchronized by checking the box.

• Select the number of Judges from 2, 3, 5, 7, or 9. Synchronized events may select from 7, 9, or 11 judges.

• Select the Formula for calculating the scores (only applicable for 7 or 9 Judges in non-synchronized events).

• Select the Type of board: 1M Springboard, 3M Springboard, or Platform.

• Select the how the dive Position will be annotated, either A-D or S-F.

• Select a Scoring type: Half-Point or Tenth-Point.

• Select the DD Table if different from FINA (Figure 38).

6. Click Next to continue.

• On the next screen (Figure 9), users may assign the diving roster.

• Fill in the information for the diver(s), and then click Add, or simply click Finish now to add divers later.

• Add or Remove divers from the roster as needed, and then click Finish.

7. Continue to click Add Event as needed, or edit or delete existing events.

8. Click Finish when all events are set up.
Run Reports
Click Run Reports from the splash screen to configure reports and printouts. This screen (Figure 10) has numerous options for printouts that can be used before or after the meet.

Select a Meet
Choose one or more events within the meet.

Printouts
Under Printouts, choose one or more of the following options:

- *Event Results - Overall*: Select to show basic meet results arranged By Rank or By Dive Order.

- *Event Results - Detailed*: Select to show more complete meet results arranged By Round or By Dive Order.

- *Dive Sheets*: Select to print dive sheets for all divers. Choose Hide scores to prevent scores and rankings from appearing on the dive sheets.

- *Dive Orders*: Select to print the dive order.

- *Announcer Script*: Select to print diver/dive order information that can be read by an announcer at the meet.

- *DD Table*: Select to print a DD table.

- *Print Options*: Set the appearance options of the printouts.

  - Select Show Border to separate each cell of information with a gray border, or select Alternating Row Color to show a row of information in white followed by a colored row. Change the row Color if applicable.
**Path & Generate Buttons**
Click **Path** to select a folder in which to save the printouts. After selecting all of the desired printout settings, click **Generate**. Reports open as HTML files in the default Internet browser. Users may then make hardcopy printouts, typically by going to **File > Print** within the Internet browser.

**Note:** With DD Table selected, as soon as **Generate** is clicked, a new window will appear telling the user to select a DD table. Find the appropriate DD table from the drop-down list, and then click **OK** to continue generating the printout(s).

**Import A Meet**
Click **Import A Meet** to import a meeting file from an external location. See **Import** for more information.

**Export A Meet**
Click **Export A Meet** to export a meeting file to an external location. See **Export** for more information.

**Configure Scoreboard**
Click **Configure Scoreboard** to adjust the display settings for matrix displays or scoreboards and other display options. See **Section 3.2** for more information.

**View Manual**
Click **View Manual** to open the PDF version of the software user manual.

**Connect to OmniSport**
Click **Connect to OmniSport** to choose the serial (COM) port to communicate with an OmniSport control console. See **Section 3.2** for more information.

### 3.2 Configuring the Software

Before creating meets, some initial communication and display options must be configured.

**Note:** Users may skip this section if the software will not be used with an OmniSport console to send data to a display or to interface with handheld judge’s consoles.

**Communication Configuration**
The Pro Diving Software can communicate with an OmniSport 2000 console in one of two ways: via network (Ethernet) or serial (COM) port.

**Network Setup**
1. Ensure there is a Cat5 Ethernet cable connected between a network router and the **ETHERNET** jack on the OmniSport 2000 timer as well as another cable running from the router to the Pro Diving computer’s network jack.
2. Power on the console, set the name, date, and time, and then select 2-DIVING.
3. Start the Pro Diving software (see **Section 2.2**).
4. Click **Connect To OmniSport** at the bottom of the splash screen (**Figure 3**).
5. On the Setup Port window (Figure 11), select UDP Ethernet, and then click OK.

To verify the connection, open a meet and check to see the indicator in the Next Diver area is green (Figure 12). The OmniSport console name will appear here as well. If this indicator is red, double-check the connections between the computer, router, and OmniSport console.

Additionally, judge consoles that are not connected will have a red box beneath their number (Figure 13). When properly connected, no box will appear.

Once the hardware and software are installed and the software is running, the OmniSport 2000 Pro system should synchronize with the timing console. The console’s LCD will then display OMNI# CONTROLLED BY PRO DIVING.

Serial Port Setup

1. Ensure a straight-through 9-pin male to 9-pin female serial cable is connected between the computer’s serial port and the J4 EXPANSION PORT on the OmniSport 2000 console (a USB-to-serial adapter may also be required).
2. Power on the console, set the name, date, and time, and then select 2-DIVING.
3. Start the Pro Diving software (see Section 2.2).
4. Click Connect To OmniSport at the bottom of the splash screen (Figure 3).
5. On the Setup Port window (Figure 14), select COM along with an available Serial Port from the drop-down list.
6. Click OK when finished.

To verify the connection, open a meet and check to see the indicator in the Next Diver area is green (Figure 12). If this indicator is red, double-check the serial connection between the computer and OmniSport console.

Additionally, judge consoles that are not connected will have a red box beneath their number (Figure 13). When properly connected, no box will appear.

Once the hardware and software are installed and the software is running, the OmniSport 2000 Pro system should synchronize with the timing console. The console’s LCD will then display CONTROLLED BY PRO DIVING.
Display Configuration

The Configure Settings window (Figure 15) contains options for outputting meet information and results to scoreboards and displays.

![Configure Settings Window](image)

**Figure 15: Configure Settings Window**

Matrix Display Settings
- **Diver Name** allows the operator to select how the divers will be listed: *First Last*, *Last, First*, *Last, Abbr.*, or *Last*.
- Determine how to display the **Affiliation** by selecting *Full Name* or *Abbreviation*.
- Select a number (2-10) of **Leaderboard Lines** to display.
- Enter a **Leaderboard Page Time** (in seconds) as needed.

Numeric (Fixed Digit) Display Settings
- Click the **Yes/No** buttons if using a *Multisport* display and whether to **Show Lead**.
- Set the number (1-10) of **Lines** the board can display.
- Select from **12 Hour** or **24 Hour** for the **Display Time**.
- Set the **Dimming Level** in increments of 10%.

Timer Port Configurations
- Under **Meet Manager Port**, use the drop-down box to select the correct timing console being used: *Omni 2000*, *Omni 6000* or *CTS*.
- Under **RTD Port**, select **RTD** or **CTS** for the type of Real Time Data output.
- Under **Scoreboard Port**, select **Multiline**, **Multidrop**, **Omega**, or **Multicast**, depending on the particular model of scoreboard in use.
- Use the **RTD Offset** setting when multiple timers are sending Real-Time Data. Select from 5,000; 10,000; or 15,000 to ensure the data from all timers is accessible.

Other Settings
- Under **Importing Dive Orders**, select whether to **Keep Dives** or **Replace Dives** after importing a meet file.
- Enabling the **Console Printer Logging** option will use the OmniSport 2000 console’s built-in printer to automatically print dive information at the end of each round.
- Turn the software **Tooltips On** or **Off**.
3.3 Main Application Screen

Diving meets take place within the main application screen (Figure 16). Here users follow the action of meets and record the scores for each diver in every event. Users may also create and edit meets, print reports, adjust the software settings, and perform all of the tasks that are available on the splash screen and more. This section discusses each area of the main application screen and how it is used.

![Main Application Screen](image)

**Figure 16: Main Application Screen**

**Events**
Use the drop-down box to quickly switch between meet events.

**Current Diver**
View the Name, Affiliation, Dive Description, Dive #, Order, and DD for the current diver(s).

**Next Diver**
View the Name, Dive #, DD, and Board for the upcoming diver(s).

**Judge Scores**
This area of the main application screen (Figure 17) includes a list of all the assigned judges with buttons for the user to accept/enter scores or to balk/fail the diver(s).

1. After a diver/team has been made active (Figure 19), click Next to begin accepting scores. If the judges are equipped with properly configured consoles, their scores will populate automatically. Otherwise, type in each judges’ score(s).

![Judge Scores](image)

**Figure 17: Judge Scores**
2. Click **Accept** when all of the scores have been entered correctly.

   **Note:** If a diver fails to dive, click **Fail** followed by **Yes** to confirm. Similarly, if the diver balked before or during the dive, click **Balk**, and then click **Yes**.

3. Click **Next** when it is time to allow scores to be entered for the next diver(s), and continue to do so until every round of the event is complete.

**Diver Statistics**

Use the three drop-down lists to select **Score to take place X**, where X would represent a place other than where the active diver/team currently sits. The software calculates how many points are needed to take the selected place (Figure 18). The number of places available to select is determined by the number of divers/teams in the event.

![Figure 18: Diver Statistics](image)

**Event Order**

Users assign the active diver(s) and make changes to the diving roster. Pro Diving offers several ways to perform the same tasks based on user preference.

**Making Divers Active**

Before scores may be entered for a diver or diving team, they must be made active. To do so, right-click a diver/team from the **Event Order** list, and select **Make Active** (Figure 19).

![Figure 19: Making a Diver Active](image)

**Adding/Removing Divers**

To Add Divers:

- Click **Add Diver**, or right-click the **Event Order** list and select **Add Diver**. This places a new diver/team at the bottom of the roster.
- Select a diver/team from the **Event Order** list, and then click **Insert Diver**, or right-click the **Event Order** list and select **Insert Diver**. This places a new diver/team before the selected diver(s).

   **Note:** Whether the user chooses to add or insert a diver, a similar window will appear (Figure 20). Fill in the appropriate diver information, and then click **Add**. If it is a synchronized event, two divers need to be entered to continue.

![Figure 20: Add or Insert Diver](image)
To Remove Divers:
Select a diver/team in the Event Order list, and click Remove Diver, or right-click a diver(s) and select Remove Diver. Click Yes to confirm the diver deletion.

Editing Scores

1. Select a diver/team from the Event Order list, and then click Edit Scores, or right-click a diver/team, and then select Edit Scores.
2. In the Edit Diver Scores window (Figure 21), type in the scores for each judge.
3. Click Accept to apply the scoring changes.

Editing Diver Information
To edit the information for a diver/team, right-click them in the Event Order list, and then select Edit Name or Edit Affiliation.

In the Edit Diver window (Figure 22), change the Diver information as needed.

Editing Dive List
To change the dives a diver performed or will be performing, right-click the diver/team and click Edit Dive List, or select the diver/team and click the Edit List button. In the Dive List window (Figure 23), type in an acceptable Dive Number from the DD Table and select a position (Pos) for each round, and then click Accept. Use the Previous and Next buttons to switch between divers’ and teams’ dive lists.

Editing Dives
Double-click a diver/team in the Event Order list to edit the dive number and position (Figure 24). If no dive number was entered, this window appears before the user is able to accept scores.

Rearranging Divers
- Select a diver/team from the Event Order list and click Move Up or Move Down to move them one position at a time.
- To move a diver/team many positions at once, simply click and drag them to the desired location in the roster.
**Cutting/Uncutting Divers**

To skip the turn of a diver/team in the roster, right-click them and select **Cut Diver**. This removes the diver/team from the competition as well as the finals. Right-click them again and select **Uncut Diver** to return to the diving rotation.

**Round**

After all divers/teams have been scored for a particular round, the next round will begin automatically. Users can switch to previous or upcoming rounds by clicking the small up and down arrows in the bottom right corner of the **Event Order** tab (*Figure 25*).

**Ranking**

Click the **Ranking** tab (*Figure 26*) to view competitors in order from highest to lowest score. Use the buttons at the bottom of the tab, or right-click a diver/team, to perform the following:

*Cut this score and below* (**Cut Below**)  
Click to skip a selected diver/team and every diver/team below that score.

*Cut this diver only* (**Cut Diver**)  
Click to skip over the turn of a specific diver/team in the roster.

*Uncut this score and above* (**Uncut Above**)  
Click to restore a cut diver/team as well as all those above back into the roster.

*Uncut all divers* (**Uncut All**)  
Click to restore every cut diver/team back into the roster.

*Uncut this diver only* (**Uncut**)  
Click to restore a cut diver/team back into the roster.
3.4 Ribbon Menu Bar

The OmniSport Pro Diving software includes an expandable ribbon menu bar with several tabs across the top. Click a tab to see all of the available commands. Below is an explanation of each tab and its commands.

Manage Meets
Use the Manage Meets tab for creating and managing meets, divers, and events (Figure 27).

![Manage Meets Tab]

Meets
Create
Click to create a new meet. This is the same process as described in (Figure 5) on the splash screen Common Tasks.

Open
Click to open a meet. This is the same process as described in (Figure 4) on the splash screen Common Tasks.

Edit
Click to edit the currently opened meet. This is the same process as creating a meet except that previously entered information is already available for edit.

Delete
Click to delete a whole meet.
1. Select the meet to delete from the drop-down list (Figure 28).
2. Click OK.
3. Click Yes to confirm the deletion.

Copy
Click to copy some or all components of an existing meet.
1. Select the meet to be copied from the drop-down list (Figure 29).
2. Select the meet event(s) to copy.
3. Select whether to
   - Copy Divers: The copied meet will include the same divers as the original.
   - Copy Dive Lists: The copied meet will include the same dive numbers and DD table as the original.
   - Copy Scores: The divers in the copied meet will retain the same awards, totals, and ranks as the original divers.
4. Select whether to
   - **Create Finals**: The copied meet will include only uncut divers.
   - **Keep Scores**: The copied uncut divers will start with the same final scores.

   **Note**: Users may select Copy Divers or Create Finals, but not both at one time.

5. Type in a descriptive *New Meet Name*.
6. Select a *New Date* if necessary.
7. Click **Create**, and then click **Yes** to make a copy of the meet. Click **Yes** once more to immediately open the meet if desired, otherwise click **No** to stay in the current meet.

   **Note**: If using combined events, users are given the option to reorder the events before the copy is completed.

---

**Divers**

**Add/Insert/Delete**
Click each button to respectively add, insert, or delete divers. See *Adding/Removing Divers*.

---

**Events**

**Add**
Click to make a new event for the currently opened meet. See *(Figure 7)* for more information about adding events to new meets.

**Edit**
Click to edit the currently opened event. This is the same process as creating a meet except that previously entered information for the current meet is available for edit.

**Remove**
Click to delete the currently opened event. Click **Yes** to confirm the deletion.

---

**Combined**
Click to create a combined event.
Typically events move from round to round automatically, and when one event ends, the user must manually switch to the next event in the meet. With a combined event, when the first round of the first event ends, the first round of the second event will begin and continue on through the first round of every event before moving on to the second round.

1. Click the cell below the *Order* column to type in the order of the event within the combined event *(Figure 30)*. For any event that will not be included in the combined event, enter “0”.
2. Repeat step 1 until all the events are properly ordered.
3. Click **OK** when finished.

---

**Finals**
See *Copy* *(Figure 29)* for an explanation of creating a finals meet.
**In Meet**

The **In Meet** tab contains commands for adjusting the dive order, handling scores and leaderboards, and adding/deleting divers during meets (*Figure 31*).

![In Meet Tab](image)

*Figure 31: In Meet Tab*

**Dive Order**

**Up**
Select a diver/team in the *Events Order* list and click **Up** to move them one position higher in the roster.

**Down**
Select a diver/team in the *Events Order* list and click **Down** to move them one position lower in the roster.

**Scoring**

**Edit**
Select a diver/team in the *Events Order* list and click **Edit** to change their scores (*Figure 21*).

**Clear**
Click to completely erase all scores for every diver/team in each round of an event. Click **Yes** to confirm the deletion.

**Leaderboard**

**Show**
Click to view the current leaderboard (*Figure 32*). The number of divers per page and total pages available is determined by the *Display Settings* or the *Configure Leaderboard* window. Enable **Auto Page** to have the software automatically switch between pages displayed.

**Configure**
Click to set up how many *Leaderboard Lines* to show per page as well as the *Auto Page Delay* in seconds (*Figure 33*).

**Dive Order**

**Add**
Click to add a new diver/team to the bottom of the roster.

**Remove**
Click to remove a selected diver/team.

**Insert**
Click to insert a new diver/team before a selected diver/team.
Cut
Click to remove a selected diver/team from the roster.

Uncut
Click to return a selected diver/team to the roster.

Active
Click to make a selected diver/team active.

Reports
The Reports tab contains commands for generating and configuring various reports and printouts (Figure 34). After users select a report, it will open as an HTML file in the default Internet browser. Go to File > Print within the browser to print a hard copy.

![Figure 34: Reports Tab](image)

**Note:** All reports apply to the currently opened event only. Users should set the Options before generating Reports or Event Results.

Announcer
Click to print diver and dive order information that can be read by an announcer at the meet.

DD
Click to print the DD table that is being used for the current event.

Orders
Use this menu to print the dive order. After clicking Orders, users are given two choices for printing reports.

Sheets
Use this menu to print dive sheets for every diver in the event. After clicking Sheets, users are given two choices for printing reports.

  - **With Scores:** Shows scores and rankings on the dive sheets.
  - **Without Scores:** Prevents scores and rankings from appearing on the dive sheets.

Judging
Click to show how many times each judge was the high or low score per round.

Event Results
Standard
Select to show basic meet results By Rank or By Dive Order.

Detailed
Select to show more complete meet results broken down By Rank or By Diver.
Options
These settings pertain to the appearance of the reports.

- Select Border to separate each cell of information with a gray border.
- Select Row Colors to show a row of information in white followed by a colored row. Click Change Color to select a different row color, if applicable.
- Click Path to select a different folder in which to save the printouts.

Share
The Share tab includes commands for importing and exporting meets, DD tables, and rosters for use with third-party meet management software and other Pro Diving software users (Figure 35).

Meets
Import
1. Navigate to the XML file of the meet to import, and then click Open.
2. Click OK on the Import successful window.

Note: If the Replace meet? window appears, click Yes to replace the current meet, or press No to import the meet as a new meet.

Export
1. Type in a descriptive name for the XML meet file, and then click Save.
2. Click OK on the Export successful window.

DD Tables
Import
1. Navigate to the XML file of the DD table to import, and then click Open.
2. Click OK on the Import completed window.

Export
1. Type in a descriptive name for the XML DD table file, and then click Save.
2. Click OK on the DD Table exported successfully window.

Rosters
Import
1. Navigate to the XML file of the roster to import, and then click Open.
2. On the Replace? window, click Yes to replace the current rosters, or click No to add the imported roster together with the current roster.

Note: Importing rosters will not insert divers into any events.

Export
1. Type in a descriptive name for the XML roster file, and then click Save.
2. Click OK on the Rosters exported successfully window.
Setup
The Setup tab includes various program options (Figure 36).

Figure 36: Setup Tab

OmniSport Console
Connect
See Section 3.2 for more information on connecting to the OmniSport console.

Monitor
Click to open the Data Monitor program (Figure 37). This separate program shows the data received through and transmitted from the selected port. Data Monitor is primarily used for troubleshooting connectivity issues.

Figure 37: Data Monitor

Under Transmit or Receive:
- Click to remove the data.
- Click to pause the data. Click to start again.
- Click to save the data.

Display
Settings
See Section 3.2 for more information on Display Settings.
**DD Table**

*Edit*

Click to view, create, and edit DD tables and dives (*Figure 38*).

*Note:* The default FINA table cannot be deleted. While still possible to edit the table, it is recommended that users create a copy of the table with the desired changes instead.

**Creating new DD Tables**

1. Click **New Table**.
2. Type in a descriptive name for the new table, and then click **OK**.

**Copying DD Tables**

1. Select an existing DD table.
2. Click **Copy Table**.
3. Type in a descriptive name for the copied table, and then click **OK**.

**Deleting DD Tables**

1. Select an existing DD table.
2. Click **Delete Table**, and then click **Yes** to confirm the deletion.

**Editing Dives**

1. Select an existing DD table, and then double-click on a specific dive from the list. Alternately, select it and click **Edit Dive**.

   *Note:* There will be a warning if attempting to edit the official FINA table.

2. In the *Edit Degree of Difficulty* window (*Figure 39*), change the **Dive Number**, **Description**, and **Degree of Difficulty** for each platform and position as needed.

3. Click **OK** to save the dive changes.

**Adding Dives**

1. Select an existing DD table.
2. Click **Add Dive** to create a new dive.
3. Use the window that appears to fill in all the necessary dive/scoring information.
4. Click **OK** to save the new dive.

**Deleting Dives**

1. Select a DD table, and then select a specific dive from the list.
2. Click **Delete Dive** followed by **OK** to confirm the deletion.
Speech
Configure
Click to set up the speech function (Figure 40).

1. Under Diver Information, click Speak to enable or disable the voice. Individually select whether or not to have the voice read aloud the Diver Order, First Name, Last Name, Affiliation, Dive #, D.D., or Start of Round.
2. Under Scores, click Speak to enable or disable the voice. Individually select whether or not to have the voice read aloud the Judge Scores, Award, or Total Score.
3. Under Voice, select a voice from the list of voices that are installed on the system.
4. Select the speech Rate from 1 (slowest) to 10 (fastest).
5. Click Test under either Diver Information or Scores to listen to the selected voice read the selected information at the selected rate.
6. Click Save to retain the speech options or Cancel to discard the changes.

Web
Configure
Click to configure the settings to broadcast live diving scores over the Internet (Figure 41).

1. Click Enable.
2. Under Access, enter the User Name, Password, and Web Address.
3. Under Transmission, select FTP, HTTP, or Local; type in an appropriate File Name; and select a Speed (in seconds) for time between data transmissions.
4. Click OK to retain the web settings or Cancel to discard the changes.

Color Scheme
Select from a light gray, black, or blue color scheme for the software windows.

Help
The Help menu bar includes user guides and software information (Figure 42).

Guides
Quickstart (currently inactive)

Manual
Click to view this user manual in PDF format.

About
About
Click to view the End User License Agreement (EULA) and software version information
OmniSport Start Button
Click the OmniSport Start Button (the Daktronics ‘D’ logo) in the upper left-hand corner to view more of the most commonly used functions within the program (Figure 43).

New Meet
Click to create a new meet. This is the same process as described in Figure 5 on the splash screen Common Tasks.

Open Meet
Click to open a meet. This is the same process as described in Figure 4 on the splash screen Common Tasks.

Edit Meet
Click to edit the currently opened meet. This is the same process as creating a meet except that previously entered information is already available for edit.

Share
Go to Share > Import Meet or Export Meet to share meet files. Importing and exporting meets are discussed in the Share menu bar section.

Print
Click to generate Standard Event Results listed By Rank as an HTML file in the default Internet browser. Go to File > Print within the browser to print a hard copy.

Close
Click to exit the Pro Diving software. Click Yes to confirm or No to cancel.

Splash Screen
Click to exit the main application screen (Figure 16) and return to splash screen (Figure 3).

Options
Click to view the Configure Settings window which contains options for outputting meet information and results to scoreboards and displays. See Section 3.2 for more information on the Display Configuration.

Exit
Click to exit the Pro Diving software. Click Yes to confirm or No to cancel.

Recent Meets
This area displays recently opened/created meets. Click a meet name in the list to open it.
Quick Access Toolbar
The layout of the menu bar is fully customizable. Click the small arrow button next to the OmniSport Start Button to open the Customize Quick Access Toolbar menu (Figure 44).

Customize Quick Access Toolbar
Click to open the Customize Quick Access Toolbar window (Figure 45).

1. Under Choose commands from, select a general category of commands in the drop-down list.
2. In the left white box, select a specific command.
3. Click Add >> to place this command on the Quick Access Toolbar.
4. Repeat steps 1-3 to add up to 20 additional buttons to the toolbar.
5. To remove any buttons, click the command in the right white box, and then click Remove.
6. Click and drag the commands in the right white box to arrange them in any order.
7. Click OK to save the Quick Access Toolbar buttons (Figure 46).

Maximize/Minimize the Ribbon (currently inactive)

Keyboard Shortcuts
In addition to buttons and menus, the Pro Diving software includes keyboard shortcuts for certain commands for quicker access.

<table>
<thead>
<tr>
<th>Keyboard Shortcuts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl] + [0-9]</td>
<td>Switch between events, with [0] for event 10</td>
</tr>
<tr>
<td>[Ctrl] + [A]</td>
<td>Add a new diver/team</td>
</tr>
<tr>
<td>[Ctrl] + [T]</td>
<td>Make a diver/team active (after selecting one)</td>
</tr>
<tr>
<td>[Ctrl] + [I]</td>
<td>Insert a new diver/team (after selecting one)</td>
</tr>
<tr>
<td>[Ctrl] + [R]</td>
<td>Remove a diver/team (after selecting one)</td>
</tr>
<tr>
<td>[Ctrl] + [S]</td>
<td>Edit scores (after selecting a diver/team)</td>
</tr>
<tr>
<td>[Ctrl] + [N]</td>
<td>Edit name (after selecting a diver/team)</td>
</tr>
<tr>
<td>[Ctrl] + [L]</td>
<td>Edit dive list (after selecting a diver/team)</td>
</tr>
<tr>
<td>[Ctrl] + [C]</td>
<td>Cut a diver/team (after selecting one)</td>
</tr>
<tr>
<td>[Ctrl] + [U]</td>
<td>Uncut a diver/team (after selecting one)</td>
</tr>
</tbody>
</table>
Appendix A:  Software Revision History

Version 1.0.2.0 - Release Date: 9 November 2003
• Initial Diving release with minor fixes to improve usability.

Version 1.0.3.0 - Release Date 4 December 2003
• Fixed bug where the high and low scores were not being dropped properly in some scoring modes.
• Added XML output for the event order and scores.
• Removed the RXThread function, all functionality is now in OnReceiveData.
• Added the event number fields to the database, and added output of total scores when requested by the console.
• Added starting scores, including the dialog and custom gridlistctrl.
• Fixed a bug that didn’t allow changing the score calculation in the event setup.
• Added ability to auto-update database if new versions use database field additions.
• Added password protection to the database.

Version 1.0.3.1 - Release Date: 17 December 2003
• Added a packet sender function for debug mode only. This tests the Hy-tek interface to the console.
• Removed history comment blocks from files.
• Removed Critical Sections.
• Cleaned dead code and fixed bug with the raking not adding in the starting scores.

Version 1.0.3.2 - Release Date: 26 February 2004
• Added logging functionality for output to the timer.
• Removed dead thread function code.
• Fixed bug with 7 or 9 judges sometimes outputting the wrong score.
• Fixed install to use new DLStreams merge module, so it works on WINNT 4.0.

Version 1.0.3.3 - Release Date: 16 March 2004
• Added ability to output the full team name or the abbreviation.
• Added ability to configure diver name output, F-L, L-F, L-FI.
• Added a final results printout.
• Modified the dialog to hide judges cells that aren’t used, instead of just disabling.
• Added shortcut, Ctrl-S, to resend the last scored packet to the timer.

Version 1.0.5.0 - Release Date: 23 May 2004
• Added Synchronized Diving.
• Updated graphical skins for all dialogs.
• Added the ability to import and export DD Tables and events.

Version 1.0.5.1 - Release Date: 2 December 2005
• Fixed bug where invalid event ID caused crash.
• Fixed bug where importing an xml file said save, not open.

Version 1.0.5.2 - Release Date: 15 December 2005
• Fixed bug where an invalid event could be set as active.
• Fixed bug in the database where no default value was set for a team name.
• Fixed bug where the judge’s status bars would not update correctly.
Version 2.0.0.0 - Release Date: 11 January 2009
- Initial release for beta testing.

Version 2.0.1 - Release Date: May 6, 2009
- Changed database location to better work with vista and win7
- Small bug fixes in database tables
- Updated copyright protection services to work under newer operating systems.
- New installation icon and shortcuts.
- Fixed bug with coloring schemes under vista.
- Updated FINA Table
- Added several voice configuration options.
- Removed “Microsoft Sam” from the default speaking voice.

Version 2.0.2 - Release Date: October 9, 2010
- Small graphical fixes when resizing.
- Fixed an issue where in some situations packets were being sent too fast to the timer.

Version 2.0.3 - Release Date: May 1, 2010
- Fixed an issue with large packets when sending to take place scores.
- Changed the splash screen so that you must resume or exit. Previously it could be minimized and the main interface would appear suspended.
- Added the ability to set the default DD table
- Fixed an issue with editing the capitalization of affiliation abbreviations.
- Added support for synchro diving, 7-9-11 judges.
- Added reports for synchro diving
- Minor fixes to report graphics.
- Added check to ensure the proper console version is being used.
- Fixed a bug that in rare circumstances caused the wrong low score to be dropped.
- Added ability to page through divers in the edit dive list form.
- Consolidated dive orders reports.
- Fixed bug that did not allow .0 to be a valid score, before it forced entry of 0.0. Same with .5
- Added ability to go back to the splash screen through the menu.
- Made the main form invisible until the splash screen is closed. Some people were minimizing and becoming lost.
- Restricted non-printable characters from diver names and affiliations.
- Adjusted speech settings to account for synchro events.
- Re-factored web scoreboard and press monitor to account for 11 judges.

Version 3.0.0